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Chapter 2

2. Setting up an Android Studio 
Development Environment
Before any work can begin on developing an Android application, the first step is to configure a computer 
system to act as the development platform. This involves several steps consisting of installing the Android Studio 
Integrated Development Environment (IDE), including the Android Software Development Kit (SDK), the 
Kotlin plug-in and the OpenJDK Java development environment. 

This chapter will cover the steps necessary to install the requisite components for Android application 
development on Windows, macOS, and Linux-based systems.

2.1 System requirements
Android application development may be performed on any of the following system types:

•	 Windows 8/10/11 64-bit

•	 macOS 10.14 or later running on Intel or Apple silicon

•	 Chrome OS device with Intel i5 or higher

•	 Linux systems with version 2.31 or later of the GNU C Library (glibc)

•	 Minimum of 8GB of RAM

•	 Approximately 8GB of available disk space

•	 1280 x 800 minimum screen resolution

2.2 Downloading the Android Studio package
Most of the work involved in developing applications for Android will be performed using the Android Studio 
environment. The content and examples in this book were created based on Android Studio Koala Feature Drop 
2024.1.2 using the Android API 35 SDK (Vanilla Ice Cream), which, at the time of writing, are the latest stable 
releases. 

Android Studio is, however, subject to frequent updates, so a newer version may have been released since this 
book was published.

The latest release of Android Studio may be downloaded from the primary download page, which can be found 
at the following URL:

https://developer.android.com/studio/index.html

If this page provides instructions for downloading a newer version of Android Studio, there may be differences 
between this book and the software. A web search for “Android Studio Koala Feature Drop” should provide the 
option to download the older version if these differences become a problem. Alternatively, visit the following 
web page to find Android Studio Koala Feature Drop in the archives:

https://developer.android.com/studio/archive

https://developer.android.com/studio/index.html
https://developer.android.com/studio/archive
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2.3 Installing Android Studio
Once downloaded, the exact steps to install Android Studio differ depending on the operating system on which 
the installation is performed.

2.3.1 Installation on Windows
Locate the downloaded Android Studio installation executable file (named android-studio-<version>-windows.
exe) in a Windows Explorer window and double-click on it to start the installation process, clicking the Yes 
button in the User Account Control dialog if it appears. 

Once the Android Studio setup wizard appears, work through the various screens to configure the installation 
to meet your requirements in terms of the file system location into which Android Studio should be installed. 
When prompted to select the components to install, ensure that the Android Studio and Android Virtual Device 
options are both selected. 

Although there are no strict rules on where Android Studio should be installed on the system, the remainder 
of this book will assume that the installation was performed into C:\Program Files\Android\Android Studio and 
that the Android SDK packages have been installed into the user’s AppData\Local\Android\sdk sub-folder. Once 
the options have been configured, click the Install button to complete the installation process. 

2.3.2 Installation on macOS
Android Studio for macOS is downloaded as a disk image (.dmg) file. Once the android-studio-<version>-mac.
dmg file has been downloaded, locate it in a Finder window and double-click on it to open it, as shown in Figure 
2-1:

Figure 2-1
To install the package, drag the Android Studio icon and drop it onto the Applications folder. The Android 
Studio package will then be installed into the Applications folder of the system, a process that will typically take 
a few seconds to complete.

To launch Android Studio, locate the executable in the Applications folder using a Finder window and double-
click on it.

For future, easier access to the tool, drag the Android Studio icon from the Finder window and drop it onto the 
dock.
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2.3.3 Installation on Linux
Having downloaded the Linux Android Studio package, open a terminal window, change directory to the 
location where Android Studio is to be installed, and execute the following command:
tar xvfz /<path to package>/android-studio-<version>-linux.tar.gz

Note that the Android Studio bundle will be installed into a subdirectory named android-studio. Therefore, 
assuming that the above command was executed in /home/demo, the software packages will be unpacked into /
home/demo/android-studio.

To launch Android Studio, open a terminal window, change directory to the android-studio/bin sub-directory, 
and execute the following command:
./studio.sh

2.4 Installing additional Android SDK packages
When you launch Android Studio, the Welcome to Android Studio screen will appear as shown below:

Figure 2-2
The steps performed so far have installed the Android Studio IDE and the current set of default Android SDK 
packages. Before proceeding, it is worth taking some time to verify which packages are installed and to install 
any missing or updated packages. 

This task can be performed by clicking on the More Actions link within the welcome dialog and selecting the 
SDK Manager option from the drop-down menu. Once invoked, the Android SDK screen of the Settings dialog 
will appear as shown in Figure 2-3:
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Figure 2-3
Google pairs each release of Android Studio with a maximum supported Application Programming Interface 
(API) level of the Android SDK. In the case of Android Studio Koala Feature Drop, this is Android Vanilla Ice 
Cream (API Level 35).  This information can be confirmed using the following link:

https://developer.android.com/studio/releases#api-level-support

Immediately after installing Android Studio for the first time, it is likely that only the latest supported version 
of the Android SDK has been installed. To install older versions of the Android SDK, select the checkboxes 
corresponding to the versions and click the Apply button. The rest of this book assumes that the Android Vanilla 
Ice Cream (API Level 35) SDK is installed.

Most of the examples in this book will support older versions of Android as far back as Android 8.0 (Oreo). 
This ensures that the apps run on a wide range of Android devices. Within the list of SDK versions, enable 
the checkbox next to Android 8.0 (Oreo) and click the Apply button. Click the OK button to install the SDK 
in the resulting confirmation dialog. Subsequent dialogs will seek the acceptance of licenses and terms before 
performing the installation. Click Finish once the installation is complete.

It is also possible that updates will be listed as being available for the latest SDK. To access detailed information 
about the packages that are ready to be updated, enable the Show Package Details option located in the lower 
right-hand corner of the screen. This will display information similar to that shown in Figure 2-4:

https://developer.android.com/studio/releases#api-level-support
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Figure 2-4
The above figure highlights the availability of an update. To install the updates, enable the checkbox to the left of 
the item name and click the Apply button.

In addition to the Android SDK packages, several tools are also installed for building Android applications. To 
view the currently installed packages and check for updates, remain within the SDK settings screen and select 
the SDK Tools tab as shown in Figure 2-5:

Figure 2-5
Within the Android SDK Tools screen, make sure that the following packages are listed as Installed in the Status 
column:

•	 Android SDK Build-tools

•	 Android Emulator

•	 Android SDK Platform-tools

•	 Google Play Services

•	 Intel x86 Emulator Accelerator (HAXM installer)*

•	 Google USB Driver (Windows only)

•	 Layout Inspector image server for API 31-35
*Note that the Intel x86 Emulator Accelerator (HAXM installer) requires an Intel processor with VT-x support 
enabled. It cannot be installed on Apple silicon-based Macs or AMD-based PCs.

If any of the above packages are listed as Not Installed or requiring an update, select the checkboxes next to those 
packages and click the Apply button to initiate the installation process. If the HAXM emulator settings dialog 
appears, select the recommended memory allocation:
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Figure 2-6
Once the installation is complete, review the package list and ensure that the selected packages are listed as 
Installed in the Status column. If any are listed as Not installed, make sure they are selected and click the Apply 
button again.

2.5 Installing the Android SDK Command-line Tools
Android Studio includes tools that allow some tasks to be performed from your operating system command 
line. To install these tools on your system, open the SDK Manager, select the SDK Tools tab, and locate the 
Android SDK Command-line Tools (latest) package as shown in Figure 2-7:

 
Figure 2-7

If the command-line tools package is not already installed, enable it and click Apply, followed by OK to complete 
the installation. When the installation completes, click Finish and close the SDK Manager dialog.

For the operating system on which you are developing to be able to find these tools, it will be necessary to add 
them to the system’s PATH environment variable. 



9

Setting up an Android Studio Development Environment

Regardless of your operating system, you will need to configure the PATH environment variable to include the 
following paths (where <path_to_android_sdk_installation> represents the file system location into which you 
installed the Android SDK):
<path_to_android_sdk_installation>/sdk/cmdline-tools/latest/bin

<path_to_android_sdk_installation>/sdk/platform-tools

You can identify the location of the SDK on your system by launching the SDK Manager and referring to the 
Android SDK Location: field located at the top of the settings panel, as highlighted in Figure 2-8:

Figure 2-8
Once the location of the SDK has been identified, the steps to add this to the PATH variable are operating system 
dependent:

2.5.1 Windows 8.1
1.  On the start screen, move the mouse to the bottom right-hand corner of the screen and select Search from 

the resulting menu. In the search box, enter Control Panel. When the Control Panel icon appears in the 
results area, click on it to launch the tool on the desktop.

2.  Within the Control Panel, use the Category menu to change the display to Large Icons. From the list of 
icons, select the one labeled System.

3.  In the Environment Variables dialog, locate the Path variable in the System variables list, select it, and click  
the Edit… button. Using the New button in the edit dialog, add two new entries to the path. For example, 
assuming the Android SDK was installed into C:\Users\demo\AppData\Local\Android\Sdk, the following 
entries would need to be added:

C:\Users\demo\AppData\Local\Android\Sdk\cmdline-tools\latest\bin

C:\Users\demo\AppData\Local\Android\Sdk\platform-tools

4.  Click OK in each dialog box and close the system properties control panel.

Open a command prompt window by pressing Windows + R on the keyboard and entering cmd into the Run 
dialog. Within the Command Prompt window, enter:
echo %Path%

The returned path variable value should include the paths to the Android SDK platform tools folders. Verify that 
the platform-tools value is correct by attempting to run the adb tool as follows:
adb

The tool should output a list of command-line options when executed. 

Similarly, check the tools path setting by attempting to run the AVD Manager command-line tool (don’t worry 
if the avdmanager tool reports a problem with Java - this will be addressed later):
avdmanager

If a message similar to the following message appears for one or both of the commands, it is most likely that an 
incorrect path was appended to the Path environment variable:
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'adb' is not recognized as an internal or external command,

operable program or batch file.

2.5.2 Windows 10
Right-click on the Start menu, select Settings from the resulting menu and enter “Edit the system environment 
variables” into the Find a setting text field. In the System Properties dialog, click the Environment Variables... 
button. Follow the steps outlined for Windows 8.1 starting from step 3.

2.5.3 Windows 11
Right-click on the Start icon located in the taskbar and select Settings from the resulting menu. When the 
Settings dialog appears, scroll down the list of categories and select the “About” option. In the About screen, 
select Advanced system settings from the Related links section. When the System Properties window appears, 
click the Environment Variables... button. Follow the steps outlined for Windows 8.1 starting from step 3.

2.5.4 Linux
This configuration can be achieved on Linux by adding a command to the .bashrc file in your home directory 
(specifics may differ depending on the particular Linux distribution in use). Assuming that the Android SDK 
bundle package was installed into /home/demo/Android/sdk, the export line in the .bashrc file would read as 
follows:
export PATH=/home/demo/Android/sdk/platform-tools:/home/demo/Android/sdk/cmdline-
tools/latest/bin:/home/demo/android-studio/bin:$PATH

Note also that the above command adds the android-studio/bin directory to the PATH variable. This will enable 
the studio.sh script to be executed regardless of the current directory within a terminal window.

2.5.5 macOS
Several techniques may be employed to modify the $PATH environment variable on macOS. Arguably the 
cleanest method is to add a new file in the /etc/paths.d directory containing the paths to be added to $PATH. 
Assuming an Android SDK installation location of /Users/demo/Library/Android/sdk, the path may be configured 
by creating a new file named android-sdk in the /etc/paths.d directory containing the following lines:
/Users/demo/Library/Android/sdk/cmdline-tools/latest/bin

/Users/demo/Library/Android/sdk/platform-tools

Note that since this is a system directory, it will be necessary to use the sudo command when creating the file. 
For example:
sudo vi /etc/paths.d/android-sdk

2.6 Android Studio memory management
Android Studio is a large and complex software application with many background processes. Although 
Android Studio has been criticized in the past for providing less than optimal performance, Google has made 
significant performance improvements in recent releases and continues to do so with each new version. These 
improvements include allowing the user to configure the amount of memory used by both the Android Studio 
IDE and the background processes used to build and run apps. This allows the software to take advantage of 
systems with larger amounts of RAM. 

If you are running Android Studio on a system with sufficient unused RAM to increase these values (this feature 
is only available on 64-bit systems with 5GB or more of RAM) and find that Android Studio performance 
appears to be degraded, it may be worth experimenting with these memory settings. Android Studio may also 
notify you that performance can be increased via a dialog similar to the one shown below:
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Figure 2-9
To view and modify the current memory configuration, select the File -> Settings... main menu option (Android 
Studio -> Settings... on macOS) and, in the resulting dialog, select Appearance & Behavior followed by the  
Memory Settings option listed under System Settings in the left-hand navigation panel, as illustrated in Figure 
2-10 below:

Figure 2-10
When changing the memory allocation, be sure not to allocate more memory than necessary or than your 
system can spare without slowing down other processes. 

The IDE heap size setting adjusts the memory allocated to Android Studio and applies regardless of the 
currently loaded project. On the other hand, when a project is built and run from within Android Studio, 
several background processes (referred to as daemons) perform the task of compiling and running the app. 
When compiling and running large and complex projects, build time could be improved by adjusting the 
daemon heap settings. Unlike the IDE heap settings, these daemon settings apply only to the current project and 
can only be accessed when a project is open in Android Studio. To display the SDK Manager from within an 
open project, select the Tools -> SDK Manager... menu option from the main menu.

2.7 Updating Android Studio and the SDK
From time to time, new versions of Android Studio and the Android SDK are released. New versions of the SDK 
are installed using the Android SDK Manager. Android Studio will typically notify you when an update is ready 
to be installed. 

To manually check for Android Studio updates, use the Help -> Check for Updates... menu option from the 
Android Studio main window (Android Studio -> Check for Updates... on macOS).
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2.8 Summary
Before beginning the development of Android-based applications, the first step is to set up a suitable development 
environment. This consists of the Android SDKs and Android Studio IDE (which also includes the OpenJDK 
development environment). This chapter covers the steps necessary to install these packages on Windows, 
macOS, and Linux.
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3. Creating an Example Android App 
in Android Studio
The preceding chapters of this book have explained how to configure an environment suitable for developing 
Android applications using the Android Studio IDE. Before moving on to slightly more advanced topics, now 
is a good time to validate that all required development packages are installed and functioning correctly. The 
best way to achieve this goal is to create an Android application and compile and run it. This chapter will cover 
creating an Android application project using Android Studio. Once the project has been created, a later chapter 
will explore using the Android emulator environment to perform a test run of the application. 

3.1 About the Project
The project created in this chapter takes the form of a rudimentary currency conversion calculator (so simple, in 
fact, that it only converts from dollars to euros and does so using an estimated conversion rate). The project will 
also use one of the most basic Android Studio project templates. This simplicity allows us to introduce some  key 
aspects of Android app development without overwhelming the beginner by introducing too many concepts, 
such as the recommended app architecture and Android architecture components, at once. When following 
the tutorial in this chapter, rest assured that the techniques and code used in this initial example project will be 
covered in much greater detail later. 

3.2 Creating a New Android Project
The first step in the application development process is to create a new project within the Android Studio 
environment. Begin, therefore, by launching Android Studio so that the “Welcome to Android Studio” screen 
appears as illustrated in Figure 3-1:

Figure 3-1
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Once this window appears, Android Studio is ready for a new project to be created. To create the new project, 
click on the New Project option to display the first screen of the New Project wizard.

3.3 Creating an Activity
The next step is to define the type of initial activity to be created for the application. Options are available to 
create projects for Phone and Tablet, Wear OS, Television, or Automotive. A range of different activity types is 
available when developing Android applications, many of which will be covered extensively in later chapters. 
For this example, however, select the Phone and Tablet option from the Templates panel, followed by the option 
to create an Empty Views Activity. The Empty Views Activity option creates a template user interface consisting 
of a single TextView object.

Figure 3-2
With the Empty Views Activity option selected, click Next to continue with the project configuration.

3.4 Defining the Project and SDK Settings
In the project configuration window (Figure 3-3), set the Name field to AndroidSample. The application name is 
the name by which the application will be referenced and identified within Android Studio and is also the name 
that would be used if the completed application were to go on sale in the Google Play store.

The Package name uniquely identifies the application within the Android application ecosystem. Although this 
can be set to any string that uniquely identifies your app, it is traditionally based on the reversed URL of your 
domain name followed by the application’s name. For example, if your domain is www.mycompany.com, and the 
application has been named AndroidSample, then the package name might be specified as follows:
com.mycompany.androidsample

If you do not have a domain name, you can enter any other string into the Company Domain field, or you may 
use example.com for testing, though this will need to be changed before an application can be published:
com.example.androidsample

The Save location setting will default to a location in the folder named AndroidStudioProjects located in your 
home directory and may be changed by clicking on the folder icon to the right of the text field containing the 
current path setting.

Set the minimum SDK setting to API 26 (Oreo; Android 8.0). This minimum SDK will be used in most projects 
created in this book unless a necessary feature is only available in a more recent version. The objective here is to 
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build an app using the latest Android SDK while retaining compatibility with devices running older versions of 
Android (in this case, as far back as Android 8.0). The text beneath the Minimum SDK setting will outline the 
percentage of Android devices currently in use on which the app will run. Click on the Help me choose button 
(highlighted in Figure 3-3) to see a full breakdown of the various Android versions still in use:

Figure 3-3
Finally, change the Language menu to Kotlin and select Kotlin DSL (build.gradle.kts) as the build configuration 
language before clicking Finish to create the project.

3.5 Modifying the Example Application
Once the project has been created, the main window will appear containing our AndroidSample project, as 
illustrated in Figure 3-4 below:

Figure 3-4
The newly created project and references to associated files are listed in the Project tool window on the left side 
of the main project window. The Project tool window has several modes in which information can be displayed. 
By default, this panel should be in Android mode. This setting is controlled by the menu at the top of the panel 
as highlighted in Figure 3-5. If the panel is not currently in Android mode, use the menu to switch mode:
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Figure 3-5

3.6 Modifying the User Interface 
The user interface design for our activity is stored in a file named activity_main.xml which, in turn, is located 
under app -> res -> layout in the Project tool window file hierarchy. Once located in the Project tool window, 
double-click on the file to load it into the user interface Layout Editor tool, which will appear in the center panel 
of the Android Studio main window:

Figure 3-6
In the toolbar across the top of the Layout Editor window is a menu (currently set to Pixel in the above figure) 
which is reflected in the visual representation of the device within the Layout Editor panel. A range of other 
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device options are available by clicking on this menu.

Use the System UI Mode button ( ) to turn Night mode on and off for the device screen layout. To change 
the orientation of the device representation between landscape and portrait, use the drop-down menu showing 
the  icon. 

As we can see in the device screen, the content layout already includes a label that displays a “Hello World!” 
message. Running down the left-hand side of the panel is a palette containing different categories of user 
interface components that may be used to construct a user interface, such as buttons, labels, and text fields. 
However, it should be noted that not all user interface components are visible to the user. One such category 
consists of layouts. Android supports a variety of layouts that provide different levels of control over how visual 
user interface components are positioned and managed on the screen. Though it is difficult to tell from looking 
at the visual representation of the user interface, the current design has been created using a ConstraintLayout. 
This can be confirmed by reviewing the information in the Component Tree panel, which, by default, is located 
in the lower left-hand corner of the Layout Editor panel and is shown in Figure 3-7:

Figure 3-7
As we can see from the component tree hierarchy, the user interface layout consists of a ConstraintLayout parent 
called main and a TextView child object. 

Before proceeding, check that the Layout Editor’s Autoconnect mode is enabled. This means that as components 
are added to the layout, the Layout Editor will automatically add constraints to ensure the components are 
correctly positioned for different screen sizes and device orientations (a topic that will be covered in much greater 
detail in future chapters). The Autoconnect button appears in the Layout Editor toolbar and is represented by 
a U-shaped icon. When disabled, the icon appears with a diagonal line through it (Figure 3-8). If necessary, re-
enable Autoconnect mode by clicking on this button.

Figure 3-8
The next step in modifying the application is to add some additional components to the layout, the first of which 
will be a Button for the user to press to initiate the currency conversion. 

The Palette panel consists of two columns, with the left-hand column containing a list of view component 
categories. The right-hand column lists the components contained within the currently selected category. In 
Figure 3-9, for example, the Button view is currently selected within the Buttons category:



18

Creating an Example Android App in Android Studio

Figure 3-9
Click and drag the Button object from the Buttons list and drop it in the horizontal center of the user interface 
design so that it is positioned beneath the existing TextView widget:

Figure 3-10
The next step is to change the text currently displayed by the Button component. The panel located to the right 
of the design area is the Attributes panel. This panel displays the attributes assigned to the currently selected 
component in the layout. Within this panel, locate the text property in the Common Attributes section and 
change the current value from “Button” to “Convert”, as shown in Figure 3-11:
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Figure 3-11
The second text property with a wrench next to it allows a text property to be set, which only appears within the 
Layout Editor tool but is not shown at runtime. This is useful for testing how a visual component and the layout 
will behave with different settings without running the app repeatedly.

Just in case the Autoconnect system failed to set all of the layout connections, click on the Infer Constraints 
button (Figure 3-12) to add any missing constraints to the layout: 

Figure 3-12
It is important to explain the warning button in the top right-hand corner of the Layout Editor tool, as indicated 
in Figure 3-13. This warning indicates potential problems with the layout. For details on any problems, click on 
the button:

Figure 3-13
When clicked, the Problems tool window (Figure 3-14) will appear, describing the nature of the problems:

Figure 3-14
This tool window is divided into two panels. The left panel (marked A in the above figure) lists issues detected 
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within the layout file. In our example, only the following problem is listed:
button <Button>: Hardcoded text

When an item is selected from the list (B), the right-hand panel will update to provide additional detail on the 
problem (C). In this case, the explanation reads as follows:
Hardcoded string "Convert", should use @string resource

The tool window also includes a preview editor (D), allowing manual corrections to be made to the layout file. 

This I18N message informs us that a potential issue exists concerning the future internationalization of the 
project (“I18N” comes from the fact that the word “internationalization” begins with an “I”, ends with an “N” 
and has 18 letters in between). The warning reminds us that attributes and values such as text strings should be 
stored as resources wherever possible when developing Android applications. Doing so enables changes to the 
appearance of the application to be made by modifying resource files instead of changing the application source 
code. This can be especially valuable when translating a user interface to a different spoken language. If all of the 
text in a user interface is contained in a single resource file, for example, that file can be given to a translator, who 
will then perform the translation work and return the translated file for inclusion in the application. This enables 
multiple languages to be targeted without the necessity for any source code changes to be made. In this instance, 
we are going to create a new resource named convert_string and assign to it the string “Convert”. 

Begin by clicking on the Show Quick Fixes button (E) and selecting the Extract string resource option from the 
menu, as shown in Figure 3-15:

Figure 3-15
After selecting this option, the Extract Resource panel (Figure 3-16) will appear. Within this panel, change the 
resource name field to convert_string and leave the resource value set to Convert before clicking on the OK 
button:

Figure 3-16
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The next widget to be added is an EditText widget, into which the user will enter the dollar amount to be 
converted. From the Palette panel, select the Text category and click and drag a Number (Decimal) component 
onto the layout so that it is centered horizontally and positioned above the existing TextView widget. With the 
widget selected, use the Attributes tools window to set the hint property to “dollars”. Click on the warning icon 
and extract the string to a resource named dollars_hint.

The code written later in this chapter will need to access the dollar value entered by the user into the EditText 
field. It will do this by referencing the id assigned to the widget in the user interface layout. The default id 
assigned to the widget by Android Studio can be viewed and changed from within the Attributes tool window 
when the widget is selected in the layout, as shown in Figure 3-17:

Figure 3-17
Change the id to dollarText and, in the Rename dialog, click on the Refactor button. This ensures that any 
references elsewhere within the project to the old id are automatically updated to use the new id:

Figure 3-18
Repeat the steps to set the id of the TextView widget to textView, if necessary.

Add any missing layout constraints by clicking on the Infer Constraints button. At this point, the layout should 
resemble that shown in Figure 3-19:
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Figure 3-19

3.7 Reviewing the Layout and Resource Files
Before moving on to the next step, we will look at some internal aspects of user interface design and resource 
handling. In the previous section, we changed the user interface by modifying the activity_main.xml file using 
the Layout Editor tool. In fact, all that the Layout Editor was doing was providing a user-friendly way to edit the 
underlying XML content of the file. In practice, there is no reason why you cannot modify the XML directly to 
make user interface changes, and, in some instances, this may actually be quicker than using the Layout Editor 
tool. In the top right-hand corner of the Layout Editor panel are the View Modes buttons marked A through C 
in Figure 3-20 below:

Figure 3-20
By default, the editor will be in Design mode (button C), whereby only the visual representation of the layout is 
displayed. In Code mode (A), the editor will display the XML for the layout, while in Split mode (B), both the 
layout and XML are displayed, as shown in Figure 3-21:
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Figure 3-21
The button to the left of the View Modes button (marked B in Figure 3-20 above) is used to toggle between Code 
and Split modes quickly.

As can be seen from the structure of the XML file, the user interface consists of the ConstraintLayout component, 
which in turn, is the parent of the TextView, Button, and EditText objects. We can also see, for example, that the 
text property of the Button is set to our convert_string resource. Although complexity and content vary, all user 
interface layouts are structured in this hierarchical, XML-based way. 

As changes are made to the XML layout, these will be reflected in the layout canvas. The layout may also be 
modified visually from within the layout canvas panel, with the changes appearing in the XML listing. To 
see this in action, switch to Split mode and modify the XML layout to change the background color of the 
ConstraintLayout to a shade of red as follows:
<?xml version="1.0" encoding="utf-8"?>

<androidx.constraintlayout.widget.ConstraintLayout xmlns:android="http://schemas.
android.com/apk/res/android"

    xmlns:app="http://schemas.android.com/apk/res-auto"

    xmlns:tools="http://schemas.android.com/tools"

    android:id="@+id/main"

    android:layout_width="match_parent"

    android:layout_height="match_parent"

    tools:context=".MainActivity"

    android:background="#ff2438" >
.

.

</androidx.constraintlayout.widget.ConstraintLayout>

Note that the layout color changes in real-time to match the new setting in the XML file. Note also that a small 
red square appears in the XML editor’s left margin (also called the gutter) next to the line containing the color 
setting. This is a visual cue to the fact that the color red has been set on a property. Clicking on the red square 
will display a color chooser allowing a different color to be selected:
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Figure 3-22
Before proceeding, delete the background property from the layout file so that the background returns to the 
default setting.

Finally, use the Project panel to locate the app -> res -> values -> strings.xml file and double-click on it to load it 
into the editor. Currently, the XML should read as follows:
<resources>

    <string name="app_name">AndroidSample</string>

    <string name="convert_string">Convert</string>

    <string name="dollars_hint">dollars</string>

</resources>

To demonstrate resources in action, change the string value currently assigned to the convert_string resource to 
“Convert to Euros” and then return to the Layout Editor tool by selecting the tab for the layout file in the editor 
panel. Note that the layout has picked up the new resource value for the string. 

There is also a quick way to access the value of a resource referenced in an XML file. With the Layout Editor 
tool in Split or Code mode, click on the “@string/convert_string” property setting so that it highlights, and 
then press Ctrl-B on the keyboard (Cmd-B on macOS). Android Studio will subsequently open the strings.xml 
file and take you to the line in that file where this resource is declared. Use this opportunity to revert the string 
resource to the original “Convert” text and to add the following additional entry for a string resource that will 
be referenced later in the app code:
<resources>

    <string name="app_name">AndroidSample</string>

    <string name="convert_string">Convert</string>

    <string name="dollars_hint">dollars</string>

    <string name="no_value_string">No Value</string>
</resources>

Resource strings may also be edited using the Android Studio Translations Editor by clicking on the Open editor 
link in the top right-hand corner of the editor window. This will display the Translation Editor in the main panel 
of the Android Studio window:
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Figure 3-23
This editor allows the strings assigned to resource keys to be edited and for translations for multiple languages 
to be managed.

3.8 Adding Interaction
The final step in this example project is to make the app interactive so that when the user enters a dollar value 
into the EditText field and clicks the convert button, the converted euro value appears on the TextView. This 
involves the implementation of some event handling on the Button widget. Specifically, the Button needs to be 
configured so that a method in the app code is called when an onClick event is triggered. Event handling can 
be implemented in several ways and is covered in a later chapter entitled “An Overview and Example of Android 
Event Handling”. Return the layout editor to Design mode, select the Button widget in the layout editor, refer to 
the Attributes tool window, and specify a method named convertCurrency as shown below:

Figure 3-24
Next, double-click on the MainActivity.kt file in the Project tool window (app -> kotlin+java -> <package name> 
-> MainActivity) to load it into the code editor and add the code for the convertCurrency method to the class file 
so that it reads as follows, noting that it is also necessary to import some additional Android packages:
package com.example.androidsample

 

import android.os.Bundle

import androidx.activity.enableEdgeToEdge

import androidx.appcompat.app.AppCompatActivity

import androidx.core.view.ViewCompat

import androidx.core.view.WindowInsetsCompat

import android.view.View
import android.widget.EditText
import android.widget.TextView
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class MainActivity : AppCompatActivity() {

    override fun onCreate(savedInstanceState: Bundle?) {

        super.onCreate(savedInstanceState)

.

.

        }

    }

 

    fun convertCurrency(view: View) { 
        val dollarText: EditText = findViewById(R.id.dollarText)
        val textView: TextView = findViewById(R.id.textView)
 
        if (dollarText.text.isNotEmpty()) {
            val dollarValue = dollarText.text.toString().toFloat()
            val euroValue = dollarValue * 0.85f
            textView.text = euroValue.toString()
        } else {
            textView.text = getString(R.string.no_value_string)
        }
    }
}

The method begins by obtaining references to the EditText and TextView objects by making a call to a method 
named findViewById, passing through the id assigned within the layout file. A check is then made to ensure 
that the user has entered a dollar value, and if so, that value is extracted, converted from a String to a floating 
point value, and converted to euros. Finally, the result is displayed on the TextView widget. 

If any of this is unclear, rest assured that these concepts will be covered in greater detail in later chapters. In 
particular, the topic of accessing widgets from within code using findByViewId and an introduction to an 
alternative technique referred to as view binding will be covered in the chapter entitled “An Overview of Android 
View Binding”.

3.9 Summary
While not excessively complex, several steps are involved in setting up an Android development environment. 
Having performed those steps, it is worth working through an example to ensure the environment is correctly 
installed and configured. In this chapter, we have created an example application and then used the Android 
Studio Layout Editor tool to modify the user interface layout. In doing so, we explored the importance of using 
resources wherever possible, particularly string values, and briefly touched on layouts. Next, we looked at the 
underlying XML used to store Android application user interface designs. 

Finally, an onClick event was added to a Button connected to a method implemented to extract the user input 
from the EditText component, convert it from dollars to euros and then display the result on the TextView.

With the app ready for testing, the steps necessary to set up an emulator for testing purposes will be covered in 
detail in the next chapter.
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6. A Tour of the Android Studio User 
Interface
While it is tempting to plunge into running the example application created in the previous chapter, it involves 
using aspects of the Android Studio user interface, which are best described in advance. 

Android Studio is a powerful and feature-rich development environment that is, to a large extent, intuitive to 
use. That being said, taking the time now to gain familiarity with the layout and organization of the Android 
Studio user interface will shorten the learning curve in later chapters of the book. With this in mind, this chapter 
will provide an overview of the various areas and components of the Android Studio environment.

6.1 The Welcome Screen
The welcome screen (Figure 6-1) is displayed any time that Android Studio is running with no projects currently 
open (open projects can be closed at any time by selecting the File -> Close Project menu option). If Android 
Studio was previously exited while a project was still open, the tool will bypass the welcome screen the next time 
it is launched, automatically opening the previously active project.

Figure 6-1
In addition to a list of recent projects, the welcome screen provides options for performing tasks such as opening 
and creating projects, along with access to projects currently under version control. In addition, the Customize 
screen provides options to change the theme and font settings used by both the IDE and the editor. Android 
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Studio plugins may be viewed, installed, and managed using the Plugins option.

Additional options are available by selecting the More Actions link or using the menu shown in Figure 6-2 when 
the list of recent projects replaces the More Actions link:

Figure 6-2

6.2 The Menu Bar
The Android Studio main window will appear when a new project is created, or an existing one is opened. When 
multiple projects are open simultaneously, each will be assigned its own main window. The precise configuration 
of the window will vary depending on the operating system Android Studio is running on and which tools and 
panels were displayed the last time the project was open. The appearance, for example, of the main menu bar will 
differ depending on the host operating system. On macOS, Android Studio follows the standard convention of 
placing the menu bar along the top edge of the desktop, as illustrated in Figure 6-3:

Figure 6-3
When Android Studio is running on Windows or Linux, however, the main menu is accessed via the button 
highlighted in Figure 6-4:

Figure 6-4

6.3 The Main Window
Once a project is open, the Android Studio main window will typically resemble that of Figure 6-5:
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Figure 6-5
The various elements of the main window can be summarized as follows:

A – Toolbar – A selection of shortcuts to frequently performed actions. The toolbar buttons provide quick 
access to a select group of menu bar actions. The toolbar can be customized by right-clicking on the bar and 
selecting the Customize Toolbar… menu option. The toolbar menu shown in Figure 6-6 provides a convenient 
way to perform tasks such as creating and opening projects and switching between windows when multiple 
projects are open:

Figure 6-6
B – Navigation Bar – The navigation bar provides a convenient way to move around the files and folders that 
make up the project. Clicking on an element in the navigation bar will drop down a menu listing the sub-folders 
and files at that location, ready for selection. Similarly, clicking on a class name displays a menu listing methods 
contained within that class:
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Figure 6-7
Select a method from the list to be taken to the corresponding location within the code editor. You can hide, 
display, and change the position of this bar using the View -> Appearance -> Navigation Bar menu option.

C – Editor Window – The editor window displays the content of the file on which the developer is currently 
working. When multiple files are open, each file is represented by a tab located along the top edge of the editor, 
as shown in Figure 6-8:

Figure 6-8
D – Status Bar – The status bar displays informational messages about the project and the activities of Android 
Studio. Hovering over items in the status bar will display a description of that field. Many fields are interactive, 
allowing users to click to perform tasks or obtain more detailed status information.

Figure 6-9
The widgets displayed in the status bar can be changed using the View -> Appearance -> Status Bar Widgets 
menu.

E – Project Tool Window – The project tool window provides a hierarchical overview of the project file structure 
allowing navigation to specific files and folders to be performed. The toolbar can be used to display the project in 
several different ways. The default setting is the Android view which is the mode primarily used in the remainder 
of this book.

The project tool window is just one of many available tools within the Android Studio environment. 

6.4 The Tool Windows
In addition to the project view tool window, Android Studio also includes many other windows, which, when 
enabled, are displayed tool window bars that appear along the left and right edges of the main window and 
contain buttons for showing and hiding each of the tool windows. Figure 6-10 shows typical tool window bar 
configurations, though the buttons and their positioning may differ for your Android Studio installation.
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Figure 6-10
Clicking on a button will display the corresponding tool window, while a second click will hide the window. The 
location of a button in a tool window bar indicates the side of the window against which the window will appear 
when displayed. These positions can be changed by clicking and dragging the buttons to different locations in 
other window toolbars.

Android Studio offers a wide range of tool windows, the most commonly used of which are as follows:

•	 Project (A) – The project view provides an overview of the file structure that makes up the project allowing 
for quick navigation between files. Generally, double-clicking on a file in the project view will cause that file 
to be loaded into the appropriate editing tool.

•	 Resource Manager (B) - A tool for adding and managing resources and assets within the project, such as 
images, colors, and layout files.

•	 More Tool Windows (C) - Displays a menu containing additional tool windows not currently displayed in a 
tool window bar. When a tool window is selected from this menu, it will appear as a button in a tool window 
bar.

•	 Build (D) - Displays a real-time view of each process step while Android Studio builds the current project.

•	 Run (E)  – The run tool window becomes available when an application is currently running and provides a 
view of the results of the run together with options to stop or restart a running process. If an application fails 
to install and run on a device or emulator, this window typically provides diagnostic information about the 
problem.
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•	 App Quality Insights (F) - Provides access to the cloud-based Firebase app quality and crash analytics 
platform.

•	 Logcat (G) – The Logcat tool window provides access to the monitoring log output from a running application 
and options for taking screenshots and videos of the application and stopping and restarting a process.

•	 Problems (H) - A central location to view all of the current errors or warnings within the project. Double-
clicking on an item in the problem list will take you to the problem file and location.

•	 Terminal (I) – Provides access to a terminal window on the system on which Android Studio is running. On 
Windows systems, this is the Command Prompt interface, while on Linux and macOS systems, this takes the 
form of a Terminal prompt.

•	 Version Control (J) - This tool window is used when the project files are under source code version control, 
allowing access to Git repositories and code change history.

•	 Notifications (K) - Android Studio occasionally displays notification popups for events such as project build 
completion or the successful launch of an app on a device or emulator. The Notifications tool window provides 
a central location to review the notification history. 

•	 Gradle (L) – The Gradle tool window provides a view of the Gradle tasks that make up the project build 
configuration. The window lists the tasks involved in compiling the various elements of the project into an 
executable application. Right-click on a top-level Gradle task and select the Open Gradle Config menu option 
to load the Gradle build file for the current project into the editor. Gradle will be covered in greater detail later 
in this book.

•	 Device Manager (M) - Provides access to the Device Manager tool window where physical Android device 
connections and emulators may be added, removed, and managed. 

•	 Running Devices (N) - Contains the AVD emulator if the option has been enabled to run the emulator in a 
tool window as outlined in the chapter entitled “Creating an Android Virtual Device (AVD) in Android Studio”.

•	 Gemini (O) - Android Studio’s AI powered coding assistant. Currently in preview, this tool helps you develop 
your app by providing coding suggestions and solutions.

•	 Assistant (P) - Display the Assistant panel, the content of which will differ depending on which Android 
Studio feature you are currently using.

•	 App Inspection - Provides access to the Database and Background Task inspectors. The Database Inspector 
allows you to inspect, query, and modify your app’s databases while running. The Background Task Inspector 
allows background worker tasks created using WorkManager to be monitored and managed.

•	 Bookmarks – The Bookmarks tool window provides quick access to bookmarked files and code lines. For 
example, right-clicking on a file in the project view allows access to an Add to Bookmarks menu option. 
Similarly, you can bookmark a line of code in a source file by moving the cursor to that line and pressing the 
F11 key (F3 on macOS). All bookmarked items can be accessed through this tool window.

•	 Build Variants – The build variants tool window provides a quick way to configure different build targets 
for the current application project (for example, different builds for debugging and release versions of the 
application or multiple builds to target different device categories).

•	 Device File Explorer – Available via the View -> Tool Windows -> Device File Explorer menu, this tool window 
provides direct access to the filesystem of the currently connected Android device or emulator, allowing the 
filesystem to be browsed and files copied to the local filesystem.
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•	 Layout Inspector - Provides a visual 3D rendering of the hierarchy of components that make up a user 
interface layout.

•	 Structure – The structure tool provides a high-level view of the structure of the source file currently displayed 
in the editor. This information includes a list of items such as classes, methods, and variables in the file. 
Selecting an item from the structure list will take you to that location in the source file in the editor window.

•	 TODO – As the name suggests, this tool provides a place to review items that have yet to be completed on 
the project. Android Studio compiles this list by scanning the source files that make up the project to look for 
comments that match specified TODO patterns. These patterns can be reviewed and changed by opening the 
Settings dialog and navigating to the TODO entry listed under Editor.

6.5 The Tool Window Menus
Each tool window has its own toolbar along the top edge. The menu buttons within these toolbars vary from one 
tool to the next, though all tool windows contain an Options menu (marked A in Figure 6-11):

Figure 6-11
The Options menu allows various aspects of the window to be changed. Figure 6-12, for example, shows the 
Options menu for the Project tool window. Settings are available, for example, to undock a window and to allow 
it to float outside of the boundaries of the Android Studio main window, and to move and resize the tool panel: 

Figure 6-12
All tool windows also include a far-right button on the toolbar (marked B in Figure 6-11 above), providing an 
additional way to hide the tool window from view. A search of the items within a tool window can be performed 
by giving that window focus by clicking on it and then typing the search term (for example, the name of a file 
in the Project tool window). A search box will appear in the window’s toolbar, and items matching the search 
highlighted.
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6.6 Android Studio Keyboard Shortcuts
Android Studio includes many keyboard shortcuts to save time when performing common tasks. A complete 
keyboard shortcut keymap listing can be viewed and printed from within the Android Studio project window by 
selecting the Help -> Keyboard Shortcuts PDF menu option. You may also list and modify the keyboard shortcuts 
by opening the Settings dialog and clicking on the Keymap entry, as shown in Figure 6-13 below:

Figure 6-13

6.7 Switcher and Recent Files Navigation
Another useful mechanism for navigating within the Android Studio main window involves using the Switcher. 
Accessed via the Ctrl-Tab keyboard shortcut, the switcher appears as a panel listing both the tool windows and 
currently open files (Figure 6-14). 

Figure 6-14
Once displayed, the switcher will remain visible as long as the Ctrl key remains depressed. Repeatedly tapping 
the Tab key while holding down the Ctrl key will cycle through the various selection options while releasing the 
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Ctrl key causes the currently highlighted item to be selected and displayed within the main window.

In addition to the Switcher, the Recent Files panel provides navigation to recently opened files (Figure 6-15). 
This can be accessed using the Ctrl-E keyboard shortcut (Cmd-E on macOS). Once displayed, either the mouse 
pointer can be used to select an option, or the keyboard arrow keys can be used to scroll through the file name 
and tool window options. Pressing the Enter key will select the currently highlighted item:

Figure 6-15

6.8 Changing the Android Studio Theme
The overall theme of the Android Studio environment may be changed using the Settings dialog. Once the 
settings dialog is displayed, select the Appearance & Behavior option in the left-hand panel, followed by 
Appearance. Then, change the setting of the Theme menu before clicking on the OK button. The themes available 
will depend on the platform but usually include options such as Light, IntelliJ, Windows, High Contrast, and 
Darcula. Figure 6-16 shows an example of the main window with the Dark theme selected:

Figure 6-16
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To synchronize the Android Studio theme with the operating system light and dark mode setting, enable the 
Sync with OS option and use the drop-down menu to control which theme to use for each mode:

Figure 6-17
Hundreds of additional themes are available for download in the Android Studio Marketplace, which can be 
accessed by clicking on the Get more themes link.

6.9 Summary
The primary elements of the Android Studio environment consist of the welcome screen and main window. 
Each open project is assigned its own main window, which, in turn, consists of a menu bar, toolbar, editing and 
design area, status bar, and a collection of tool windows. Tool windows appear on the sides of the main window.

There are very few actions within Android Studio that cannot be triggered via a keyboard shortcut. A keymap of 
default keyboard shortcuts can be accessed at any time from within the Android Studio main window.
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Chapter 41

41. Modern Android App 
Architecture with Jetpack
For many years, Google did not recommend a specific approach to building Android apps other than to provide 
tools and development kits while letting developers decide what worked best for a particular project or individual 
programming style. That changed in 2017 with the introduction of the Android Architecture Components, 
which, in turn, became part of Android Jetpack when it was released in 2018.

This chapter provides an overview of the concepts of Jetpack, Android app architecture recommendations, and 
some key architecture components. Once the basics have been covered, these topics will be covered in more 
detail and demonstrated through practical examples in later chapters.

41.1 What is Android Jetpack?
Android Jetpack consists of Android Studio, the Android Architecture Components, the Android Support 
Library, and a set of guidelines recommending how an Android App should be structured. The Android 
Architecture Components are designed to make it quicker and easier to perform common tasks when developing 
Android apps while also conforming to the key principle of the architectural guidelines.

While all Android Architecture Components will be covered in this book, this chapter will focus on the key 
architectural guidelines and the ViewModel, LiveData, and Lifecycle components while introducing Data 
Binding and Repositories. 

Before moving on, it is important to understand that the Jetpack approach to app development is optional. 
While highlighting some of the shortcomings of other techniques that have gained popularity over the years, 
Google stopped short of completely condemning those approaches to app development. Google is taking the 
position that while there is no right or wrong way to develop an app, there is a recommended way. 

41.2 The “Old” Architecture
In the chapter entitled “Creating an Example Android App in Android Studio”, an Android project was created 
consisting of a single activity that contained all of the code for presenting and managing the user interface 
together with the back-end logic of the app. Until the introduction of Jetpack, the most common architecture 
followed this paradigm with apps consisting of multiple activities (one for each screen within the app), with each 
activity class to some degree mixing user interface and back-end code.

This approach led to a range of problems related to the lifecycle of an app (for example, an activity is destroyed 
and recreated each time the user rotates the device leading to the loss of any app data that had not been saved 
to some form of persistent storage) as well as issues such as inefficient navigation involving launching a new 
activity for each app screen accessed by the user. 

41.3 Modern Android Architecture
At the most basic level, Google now advocates single-activity apps where different screens are loaded as content 
within the same activity. 

Modern architecture guidelines also recommend separating different areas of responsibility within an app into 
entirely separate modules (a concept referred to as “separation of concerns”). One of the keys to this approach 
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is the ViewModel component. 

41.4 The ViewModel Component
The purpose of ViewModel is to separate the user interface-related data model and logic of an app from the 
code responsible for displaying and managing the user interface and interacting with the operating system. 
When designed this way, an app will consist of one or more UI Controllers, such as an activity, together with 
ViewModel instances responsible for handling the data those controllers need.

The ViewModel only knows about the data model and corresponding logic. It knows nothing about the user 
interface and does not attempt to directly access or respond to events relating to views within the user interface. 
When a UI controller needs data to display, it asks the ViewModel to provide it. Similarly, when the user enters 
data into a view within the user interface, the UI controller passes it to the ViewModel for handling.

This separation of responsibility addresses the issues relating to the lifecycle of UI controllers. Regardless of how 
often the UI controller is recreated during the lifecycle of an app, the ViewModel instances remain in memory, 
thereby maintaining data consistency. For example, a ViewModel used by an activity will remain in memory 
until the activity finishes, which, in the single activity app, is not until the app exits.

Figure 41-1

41.5 The LiveData Component
Consider an app that displays real-time data, such as the current price of a financial stock. The app could 
use a stock price web service to continuously update the data model within the ViewModel with the latest 
information. This real-time data is of use only if it is displayed to the user promptly. There are only two ways that 
the UI controller can ensure that the latest data is displayed in the user interface. One option is for the controller 
to continuously check with the ViewModel to determine if the data has changed since it was last displayed. 
However, the problem with this approach is that it could be more efficient. To maintain the real-time nature of 
the data feed, the UI controller would have to run on a loop, continuously checking for the data to change.

A better solution would be for the UI controller to receive a notification when a specific data item within a 
ViewModel changes. This is made possible by using the LiveData component. LiveData is a data holder that 
allows a value to become observable. In basic terms, an observable object can notify other objects when changes 
to its data occur, thereby solving the problem of ensuring that the user interface always matches the data within 
the ViewModel.

This means, for example, that a UI controller interested in a ViewModel value can set up an observer, which will, 
in turn, be notified when that value changes. In our hypothetical application, for example, the stock price would 
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be wrapped in a LiveData object within the ViewModel, and the UI controller would assign an observer to the 
value, declaring a method to be called when the value changes. When triggered by data change, this method will 
read the updated value from the ViewModel and use it to update the user interface.

Figure 41-2
A LiveData instance may also be declared as mutable, allowing the observing entity to update the underlying 
value held within the LiveData object. The user might, for example, enter a value in the user interface that needs 
to overwrite the value stored in the ViewModel.

Another of the key advantages of using LiveData is that it is aware of the lifecycle state of its observers. If, 
for example, an activity contains a LiveData observer, the corresponding LiveData object will know when the 
activity’s lifecycle state changes and respond accordingly. If the activity is paused (perhaps the app is put into the 
background), the LiveData object will stop sending events to the observer. Suppose the activity has just started 
or resumes after being paused. In that case, the LiveData object will send a LiveData event to the observer so 
that the activity has the most up-to-date value. Similarly, the LiveData instance will know when the activity is 
destroyed and remove the observer to free up resources.

So far, we’ve only talked about UI controllers using observers. In practice, however, an observer can be used 
within any object that conforms to the Jetpack approach to lifecycle management.

41.6 ViewModel Saved State
Android allows the user to place an active app in the background and return to it after performing other tasks 
on the device (including running other apps). When a device runs low on resources, the operating system will 
rectify this by terminating background app processes, starting with the least recently used app. However, when 
the user returns to the terminated background app, it should appear in the same state as when it was placed in 
the background, regardless of whether it was terminated. In terms of the data associated with a ViewModel, this 
can be implemented using the ViewModel Saved State module. This module allows values to be stored in the 
app’s saved state and restored in case of system-initiated process termination. This topic will be covered later in 
the “An Android ViewModel Saved State Tutorial” chapter.

41.7 LiveData and Data Binding
Android Jetpack includes the Data Binding Library, which allows data in a ViewModel to be mapped directly to 
specific views within the XML user interface layout file. In the AndroidSample project created earlier, code had 
to be written to obtain references to the EditText and TextView views and to set and get the text properties to 
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reflect data changes. Data binding allows the LiveData value stored in the ViewModel to be referenced directly 
within the XML layout file avoiding the need to write code to keep the layout views updated.

Figure 41-3
Data binding will be covered in greater detail, starting with the chapter “An Overview of Android Jetpack Data 
Binding”. 

41.8 Android Lifecycles
The duration from when an Android component is created to the point that it is destroyed is called the lifecycle. 
During this lifecycle, the component will change between different lifecycle states, usually under the operating 
system’s control and in response to user actions. An activity, for example, will begin in the initialized state before 
transitioning to the created state. Once the activity runs, it will switch to the started state, from which it will cycle 
through various states, including created, started, resumed, and destroyed.

Many Android Framework classes and components allow other objects to access their current state. Lifecycle 
observers may also be used so that an object receives a notification when the lifecycle state of another object 
changes. The ViewModel component uses this technique behind the scenes to identify when an observer 
has restarted or been destroyed. This functionality is not limited to Android framework and architecture 
components. It may also be built into any other classes using a set of lifecycle components included with the 
architecture components. 

Objects that can detect and react to lifecycle state changes in other objects are said to be lifecycle-aware. In 
contrast, objects that provide access to their lifecycle state are called lifecycle owners. The chapter entitled 
“Working with Android Lifecycle-Aware Components” will cover Lifecycles in greater detail.

41.9 Repository Modules
If a ViewModel obtains data from one or more external sources (such as databases or web services, it is important 
to separate the code involved in handling those data sources from the ViewModel class. Failure to do this would, 
after all, violate the separation of concerns guidelines. To avoid mixing this functionality with the ViewModel, 
Google’s architecture guidelines recommend placing this code in a separate Repository module.

A repository is not an Android architecture component but a Kotlin class created by the app developer that is 
responsible for interfacing with the various data sources. The class then provides an interface to the ViewModel, 
allowing that data to be stored in the model.



321

Modern Android App Architecture with Jetpack

Figure 41-4

41.10 Summary
Until recently, Google has tended not to recommend any particular approach to structuring an Android app. 
That has now changed with the introduction of Android Jetpack, consisting of tools, components, libraries, and 
architecture guidelines. Google now recommends that an app project be divided into separate modules, each 
responsible for a particular area of functionality, otherwise known as “separation of concerns”.

In particular, the guidelines recommend separating the view data model of an app from the code responsible 
for handling the user interface. In addition, the code responsible for gathering data from data sources such as 
web services or databases should be built into a separate repository module instead of being bundled with the 
view model.

Android Jetpack includes the Android Architecture Components, designed to make developing apps that 
conform to the recommended guidelines easier. This chapter has introduced the ViewModel, LiveData, and 
Lifecycle components. These will be covered in more detail, starting with the next chapter. Other architecture 
components not mentioned in this chapter will be covered later in the book.
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42. An Android ViewModel Tutorial
The previous chapter introduced the fundamental concepts of Android Jetpack and outlined the basics of 
modern Android app architecture. Jetpack defines a set of recommendations describing how an Android app 
project should be structured while providing a set of libraries and components that make it easier to conform to 
these guidelines to develop reliable apps with less coding and fewer errors.

To help reinforce and clarify the information provided in the previous chapter, this chapter will step through 
creating an example app project that uses the ViewModel component. The next chapter will further enhance this 
example by including LiveData and data binding support.

42.1 About the Project
In the chapter entitled “Creating an Example Android App in Android Studio”, a project named AndroidSample 
was created in which all of the code for the app was bundled into the main Activity class file. In the following 
chapter, an AVD emulator was created and used to run the app. While the app was running, we experienced 
first-hand the problems that occur when developing apps in this way when the data displayed on a TextView 
widget was lost during a device rotation.

This chapter will implement the same currency converter app, using the ViewModel component and following 
the Google app architecture guidelines to avoid Activity lifecycle complications.

42.2 Creating the ViewModel Example Project
When the AndroidSample project was created, the Empty Views Activity template was chosen as the basis for 
the project. However, the Basic Views Template template will be used for this project. 

Select the New Project option from the welcome screen and, within the resulting new project dialog, choose the 
Basic Views Activity template before clicking on the Next button.

Enter ViewModelDemo into the Name field and specify com.ebookfrenzy.viewmodeldemo as the package name. 
Before clicking on the Finish button, change the Minimum API level setting to API 26: Android 8.0 (Oreo) and 
the Language menu to Kotlin. 

42.3 Removing Unwanted Project Elements
As outlined in the “A Guide to the Android Studio Layout Editor Tool”, the Basic Views Activity template includes 
features not required by all projects. Before adding the ViewModel to the project, we first need to remove the 
navigation features, the second content fragment, and the floating action button as follows:

1.  Double-click on the activity_main.xml layout file in the Project tool window, select the floating action 
button, and tap the keyboard delete key to remove the object from the layout.

2.  Edit the MainActivity.kt file and remove the floating action button code from the onCreate method as 
follows:

override fun onCreate(savedInstanceState: Bundle?) {

.

.

    binding.fab.setOnClickListener { view ->
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        Snackbar.make(view, "Replace with your own action", Snackbar.LENGTH_LONG)

            .setAnchorView(R.id.fab)

            .setAction("Action", null).show()

    }

}

3.  Within the Project tool window, navigate to and double-click on the app -> res -> navigation -> nav_graph.
xml file to load it into the navigation editor.

4.  Within the editor, select the SecondFragment entry in the graph panel and tap the keyboard delete key to 
remove it from the graph.

5.  Locate and delete the SecondFragment.kt and fragment_second.xml files. 

6.  The final task is to remove some code from the FirstFragment class so that the Button view no longer 
navigates to the now non-existent second fragment when clicked. Edit the FirstFragment.kt file and remove 
the code from the onViewCreated() method so that it reads as follows:

override fun onViewCreated(view: View, savedInstanceState: Bundle?) {

    super.onViewCreated(view, savedInstanceState)

 

    binding.buttonFirst.setOnClickListener {

        findNavController().navigate(R.id.action_FirstFragment_to_SecondFragment)

    }

}

42.4 Designing the Fragment Layout
The next step is to design the layout of the fragment. First, locate the fragment_first.xml file in the Project tool 
window and double-click on it to load it into the layout editor. Once the layout has loaded, select and delete 
the existing Button, TextView, and ConstraintLayout components. Next, right-click on the NestedScrollView 
instance in the Component Tree panel and select the Convert NestedScrollView to ConstraintLayout menu option 
as shown in Figure 42-1, and accept the default settings in the resulting dialog: 

Figure 42-1
Select the converted ConstraintLayout component and use the Attributes tool window to change the id to 
constraintLayout.

Add a new TextView, position it in the center of the layout, and change the id to resultText. Next, drag a Number 
(Decimal) view from the palette and position it above the existing TextView. With the view selected in the 
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layout, refer to the Attributes tool window and change the id to dollarText.

Drag a Button widget onto the layout to position it below the TextView, and change the text attribute to read 
“Convert”. With the button still selected, change the id property to convertButton. At this point, the layout should 
resemble that illustrated in Figure 42-2 (note that the three views have been constrained using a vertical chain):

Figure 42-2
Finally, click on the warning icon in the top right-hand corner of the layout editor and convert the hard-coded 
strings to resources.

42.5 Implementing the View Model
With the user interface layout completed, the data model for the app needs to be created within the view model. 
Begin by locating the com.ebookfrenzy.viewmodeldemo entry in the Project tool window, right-clicking on it, 
and selecting the New -> Kotlin Class/File menu option. Name the new class MainViewModel and press the 
keyboard enter key. Edit the new class file so that it reads as follows:
package com.ebookfrenzy.viewmodeldemo

 

import androidx.lifecycle.ViewModel
 
class MainViewModel : ViewModel() {
 
    private val rate = 0.74f
    private var dollarText = ""
    private var result: Float = 0f
 
    fun setAmount(value: String) {
        this.dollarText = value
        result = value.toFloat() * rate
    }
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    fun getResult(): Float {
        return result
    }
}

The class declares variables to store the current dollar string value and the converted amount together with 
getter and setter methods to provide access to those data values. When called, the setAmount() method takes 
the current dollar amount as an argument and stores it in the local dollarText variable. The dollar string value 
is converted to a floating point number, multiplied by a fictitious exchange rate, and the resulting euro value is 
stored in the result variable. The getResult() method, on the other hand, returns the current value assigned to 
the result variable.

42.6 Associating the Fragment with the View Model
There needs to be some way for the fragment to obtain a reference to the ViewModel to access the model and 
observe data changes. A Fragment or Activity maintains references to the ViewModels on which it relies for data 
using an instance of the ViewModelProvider class. 

A ViewModelProvider instance is created using the ViewModelProvider class from within the Fragment. 
When called, the class initializer is passed a reference to the current Fragment or Activity and returns a 
ViewModelProvider instance as follows:
val viewModelProvider = ViewModelProvider(this)

Once the ViewModelProvider instance has been created, an index value can be used to request a specific 
ViewModel class. The provider will then either create a new instance of that ViewModel class or return an 
existing instance, for example:
val viewModel = ViewModelProvider(this)[MyViewModel::class.java]

Edit the FirstFragment.kt file and override the onCreate() method to set up the ViewModelProvider:
.

.

import androidx.lifecycle.ViewModelProvider
.

.

class FirstFragment : Fragment() {

.

.

    private lateinit var viewModel: MainViewModel
 
    override fun onCreate(savedInstanceState: Bundle?) {
        super.onCreate(savedInstanceState)
        viewModel = ViewModelProvider(this)[MainViewModel::class.java]
    }
.

.

With access to the model view, code can now be added to the Fragment to begin working with the data model.



327

An Android ViewModel Tutorial

42.7 Modifying the Fragment
The fragment class needs to be updated to react to button clicks and interact with the data values stored in the 
ViewModel. The class will also need references to the three views in the user interface layout to react to button 
clicks, extract the current dollar value, and display the converted currency amount.

In the chapter entitled “Creating an Example Android App in Android Studio”, the onClick property of the 
Button widget was used to designate the method to be called when the user clicks the button. Unfortunately, this 
property can only call methods on an Activity and cannot be used to call a method in a Fragment. To overcome 
this limitation, we must add some code to the Fragment class to set up an onClick listener on the button. This 
can be achieved in the onViewCreated() lifecycle method in the FirstFragment.kt file as outlined below:
override fun onViewCreated(view: View, savedInstanceState: Bundle?) {

    super.onViewCreated(view, savedInstanceState)

    

    binding.convertButton.setOnClickListener {
 
    }
}

With the listener added, any code placed within the onClick() method will be called whenever the user clicks 
the button. 

42.8 Accessing the ViewModel Data
When the button is clicked, the onClick() method needs to read the current value from the EditText view, confirm 
that the field is not empty, and then call the setAmount() method of the ViewModel instance. The method will 
then need to call the ViewModel’s getResult() method and display the converted value on the TextView widget. 

Since LiveData has yet to be used in the project, it will also be necessary to get the latest result value from the 
ViewModel each time the Fragment is created.

Remaining in the FirstFragment.kt file, implement these requirements as follows in the onViewCreated() method:
.

.

override fun onViewCreated(view: View, savedInstanceState: Bundle?) {

    super.onViewCreated(view, savedInstanceState)

 

    binding.resultText.text = viewModel.getResult().toString()
 

    binding.convertButton.setOnClickListener {

        if (binding.dollarText.text.isNotEmpty()) {
            viewModel.setAmount(binding.dollarText.text.toString())
            binding.resultText.text = viewModel.getResult().toString()
        } else {
            binding.resultText.text = "No Value"
        }
    }

}
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42.9 Testing the Project
With this project development phase completed, build and run the app on the simulator or a physical device, 
enter a dollar value, and click the Convert button. The converted amount should appear on the TextView, 
indicating that the UI controller and ViewModel re-structuring is working as expected.

When the original AndroidSample app was run, rotating the device caused the value displayed on the resultText 
TextView widget to be lost. Repeat this test now with the ViewModelDemo app and note that the current euro 
value is retained after the rotation. This is because the ViewModel remained in memory as the Fragment was 
destroyed and recreated, and code was added to the onViewCreated() method to update the TextView with the 
result data value from the ViewModel each time the Fragment re-started.

While this is an improvement on the original AndroidSample app, much more can be done to simplify the 
project by using LiveData and data binding, both of which are the topics of the next chapters.

42.10 Summary
In this chapter, we revisited the AndroidSample project created earlier in the book and created a new version 
of the project structured to comply with the Android Jetpack architectural guidelines. The example project also 
demonstrated the use of ViewModels to separate data handling from user interface-related code. Finally, the 
chapter showed how the ViewModel approach avoids problems handling Fragment and Activity lifecycles.
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63. An Introduction to Kotlin 
Coroutines
When an Android application is first started, the runtime system creates a single thread in which all components 
will run by default. This thread is generally referred to as the main thread. The primary role of the main thread 
is to handle the user interface in terms of event handling and interaction with views in the user interface. Any 
additional components started within the application will, by default, also run on the main thread.

Any code within an application that performs a time-consuming task using the main thread will cause the 
entire application to appear to lock up until the task is completed. This typically results in the operating system 
displaying an “Application is not responding” warning to the user. This is far from the desired behavior for 
any application. Fortunately, Kotlin provides a lightweight alternative in the form of Coroutines. This chapter 
will introduce Coroutines, including terminology such as dispatchers, coroutine scope, suspend functions, 
coroutine builders, and structured concurrency. The chapter will also explore channel-based communication 
between coroutines.

63.1 What are Coroutines?
Coroutines are blocks of code that execute asynchronously without blocking the thread from which they 
are launched. Coroutines can be implemented without worrying about building complex AsyncTask 
implementations or directly managing multiple threads. Because of the way they are implemented, coroutines 
are much more efficient and less resource intensive than using traditional multi-threading options. Coroutines 
also make for code that is much easier to write, understand and maintain since it allows code to be written 
sequentially without having to write callbacks to handle thread-related events and results.

Although a relatively recent addition to Kotlin, there is nothing new or innovative about coroutines. Coroutines, 
in one form or another, have existed in programming languages since the 1960s and are based on a model 
known as Communicating Sequential Processes (CSP). Though it does so efficiently, Kotlin still uses multi-
threading behind the scenes. 

63.2 Threads vs. Coroutines
A problem with threads is that they are a finite resource and expensive in terms of CPU capabilities and system 
overhead. In the background, much work is involved in creating, scheduling, and destroying a thread. Although 
modern CPUs can run large numbers of threads, the actual number of threads that can be run in parallel at 
any one time is limited by the number of CPU cores (though newer CPUs have 8 cores, most Android devices 
contain CPUs with 4 cores). When more threads are required than there are CPU cores, the system has to 
perform thread scheduling to decide how the execution of these threads is to be shared between the available 
cores.

To avoid these overheads, instead of starting a new thread for each coroutine and destroying it when the 
coroutine exits, Kotlin maintains a pool of active threads and manages how coroutines are assigned to those 
threads. When an active coroutine is suspended, the Kotlin runtime saves it, and another coroutine resumes to 
take its place. When the coroutine is resumed, it is restored to an existing unoccupied thread within the pool to 
continue executing until it either completes or is suspended. Using this approach, a limited number of threads 
are used efficiently to execute asynchronous tasks with the potential to perform large numbers of concurrent 
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tasks without the inherent performance degeneration that would occur using standard multi-threading. 

63.3 Coroutine Scope
All coroutines must run within a specific scope, allowing them to be managed as groups instead of as individual 
ones. This is particularly important when canceling and cleaning up coroutines, for example, when a Fragment 
or Activity is destroyed, and ensuring that coroutines do not “leak” (in other words, continue running in the 
background when the app no longer needs them). By assigning coroutines to a scope, they can, for example, all 
be canceled in bulk when they are no longer needed. 

Kotlin and Android provide built-in scopes and the option to create custom scopes using the CoroutineScope 
class. The built-in scopes can be summarized as follows:

•	 GlobalScope – GlobalScope is used to launch top-level coroutines tied to the entire application lifecycle. 
Since this has the potential for coroutines in this scope to continue running when not needed (for example, 
when an Activity exits), use of this scope is not recommended for Android applications. Coroutines running 
in GlobalScope are considered to be using unstructured concurrency.

•	 ViewModelScope – Provided specifically for ViewModel instances when using the Jetpack architecture 
ViewModel component. Coroutines launched in this scope from within a ViewModel instance are automatically 
canceled by the Kotlin runtime system when the corresponding ViewModel instance is destroyed.

•	 LifecycleScope -  Every lifecycle owner has associated with it a LifecycleScope. This scope is canceled when 
the corresponding lifecycle owner is destroyed, making it particularly useful for launching coroutines from 
within activities and fragments. 

For all other requirements, a custom scope will likely be used. The following code, for example, creates a custom 
scope named myCoroutineScope:
private val myCoroutineScope = CoroutineScope(Dispatchers.Main)

The coroutineScope declares the dispatcher that will be used to run coroutines (though this can be overridden) 
and must be referenced each time a coroutine is started if it is to be included within the scope. All of the running 
coroutines in a scope can be canceled via a call to the cancel() method of the scope instance:
myCoroutineScope.cancel()

63.4 Suspend Functions
A suspend function is a special type of Kotlin function that contains the code of a coroutine. It is declared 
using the Kotlin suspend keyword, which indicates to Kotlin that the function can be paused and resumed later, 
allowing long-running computations to execute without blocking the main thread.

The following is an example suspend function:
suspend fun mySlowTask() {

    // Perform long-running tasks here    

}

63.5 Coroutine Dispatchers
Kotlin maintains threads for different types of asynchronous activity, and when launching a coroutine, it will be 
necessary to select the appropriate dispatcher from the following options:

•	 Dispatchers.Main – Runs the coroutine on the main thread and is suitable for coroutines that need to make 
changes to the UI and as a general-purpose option for performing lightweight tasks.

•	 Dispatchers.IO – Recommended for coroutines that perform network, disk, or database operations.
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•	 Dispatchers.Default – Intended for CPU-intensive tasks such as sorting data or performing complex 
calculations.

The dispatcher is responsible for assigning coroutines to appropriate threads and suspending and resuming the 
coroutine during its lifecycle. In addition to the predefined dispatchers, it is also possible to create dispatchers 
for your own custom thread pools.

63.6 Coroutine Builders
The coroutine builders bring together all of the components covered so far and launch the coroutines so that 
they start executing. For this purpose, Kotlin provides the following six builders:

•	 launch – Starts a coroutine without blocking the current thread and does not return a result to the caller. Use 
this builder when calling a suspend function from within a traditional function and when the results of the 
coroutine do not need to be handled (sometimes referred to as “fire and forget” coroutines).

•	 async – Starts a coroutine and allows the caller to wait for a result using the await() function without blocking 
the current thread. Use async when you have multiple coroutines that need to run in parallel. The async 
builder can only be used from within another suspend function.

•	 withContext – Allows a coroutine to be launched in a different context from that used by the parent coroutine. 
Using this builder, a coroutine running using the Main context could launch a child coroutine in the Default 
context. The withContext builder also provides a useful alternative to async when returning results from a 
coroutine.

•	 coroutineScope – The coroutineScope builder is ideal for situations where a suspend function launches 
multiple coroutines that will run in parallel and where some action must occur only when all the coroutines 
reach completion. If those coroutines are launched using the coroutineScope builder, the calling function will 
not return until all child coroutines have completed. When using coroutineScope, a failure in any coroutine 
will cancel all other coroutines.

•	 supervisorScope – Similar to the coroutineScope outlined above, except that a failure in one child does not 
result in the cancellation of the other coroutines.

•	 runBlocking - Starts a coroutine and blocks the current thread until the coroutine reaches completion. This 
is typically the exact opposite of what is wanted from coroutines but is useful for testing code and when 
integrating legacy code and libraries. Otherwise to be avoided. 

63.7 Jobs
Each call to a coroutine builder, such as launch or async, returns a Job instance which can, in turn, be used 
to track and manage the lifecycle of the corresponding coroutine. Subsequent builder calls from within the 
coroutine create new Job instances, which will become children of the immediate parent Job, forming a parent-
child relationship tree where canceling a parent Job will recursively cancel all its children. Canceling a child does 
not, however, cancel the parent, though an uncaught exception within a child created using the launch builder 
may result in the cancellation of the parent (this is not the case for children created using the async builder, 
which encapsulates the exception in the result returned to the parent).

The status of a coroutine can be identified by accessing the isActive, isCompleted, and isCancelled properties of 
the associated Job object. In addition to these properties, several methods are also available on a Job instance. 
For example, a Job and all of its children may be canceled by calling the cancel() method of the Job object, while 
a call to the cancelChildren() method will cancel all child coroutines. 

The join() method can be called to suspend the coroutine associated with the job until all of its child jobs have 
completed. To perform this task and cancel the Job once all child jobs have completed, call the cancelAndJoin() 
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method. 

This hierarchical Job structure, together with coroutine scopes, form the foundation of structured concurrency, 
which aims to ensure that coroutines do not run longer than required without manually keeping references to 
each coroutine.

63.8 Coroutines – Suspending and Resuming
It helps to see some coroutine examples in action to understand coroutine suspension better. To start with, let’s 
assume a simple Android app containing a button that, when clicked, calls a function named startTask(). This 
function calls a suspend function named performSlowTask() using the Main coroutine dispatcher. The code for 
this might read as follows:
private val myCoroutineScope = CoroutineScope(Dispatchers.Main)

 

fun startTask(view: View) {

    myCoroutineScope.launch(Dispatchers.Main) {

        performSlowTask()

    }

}

In the above code, a custom scope is declared and referenced in the call to the launch builder, which, in turn, 
calls the performSlowTask() suspend function. Since startTask() is not a suspend function, the coroutine must be 
started using the launch builder instead of the async builder.

Next, we can declare the performSlowTask() suspend function as follows:
suspend fun performSlowTask() {

    Log.i(TAG, "performSlowTask before")

    delay(5_000) // simulates long-running task

    Log.i(TAG, "performSlowTask after")

}

As implemented, all the function does is output diagnostic messages before and after performing a 5-second 
delay, simulating a long-running task. While the 5-second delay is in effect, the user interface will continue 
to be responsive because the main thread is not being blocked. To understand why it helps to explore what is 
happening behind the scenes. 

First, the startTask() function is executed and launches the performSlowTask() suspend function as a coroutine. 
This function then calls the Kotlin delay() function passing through a time value. The built-in Kotlin delay() 
function is implemented as a suspend function, so it is also launched as a coroutine by the Kotlin runtime 
environment. The code execution has now reached what is referred to as a suspend point which will cause the 
performSlowTask() coroutine to be suspended while the delay coroutine is running. This frees up the thread on 
which performSlowTask() was running and returns control to the main thread so that the UI is unaffected.

Once the delay() function reaches completion, the suspended coroutine will be resumed and restored to a thread 
from the pool where it can display the Log message and return to the startTask() function.

When working with coroutines in Android Studio suspend points within the code editor are marked as shown 
in the figure below:
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Figure 63-1

63.9 Returning Results from a Coroutine
The above example ran a suspend function as a coroutine but did not demonstrate how to return results. 
However, suppose the performSlowTask() function is required to return a string value to be displayed to the user 
via a TextView object. 

To do this, we must rewrite the suspend function to return a Deferred object. A Deferred object is a commitment 
to provide a value at some point in the future. By calling the await() function on the Deferred object, the Kotlin 
runtime will deliver the value when the coroutine returns it. The code in our startTask() function might, 
therefore, be rewritten as follows:
fun startTask(view: View) {

 

    coroutineScope.launch(Dispatchers.Main) {

        statusText.text = performSlowTask().await()

    }

}

The problem now is that we are having to use the launch builder to start the coroutine since startTask() is not a 
suspend function. As outlined earlier in this chapter, it is only possible to return results when using the async 
builder. To get around this, we have to adapt the suspend function to use the async builder to start another 
coroutine that returns a Deferred result:
suspend fun performSlowTask(): Deferred<String> =

    coroutineScope.async(Dispatchers.Default) {

        Log.i(TAG, "performSlowTask before")

        delay(5_000)

        Log.i(TAG, "performSlowTask after")

    return@async "Finished"

}

When the app runs, the “Finished” result string will be displayed on the TextView object when the 
performSlowTask() coroutine completes. Once again, the wait for the result will occur in the background without 
blocking the main thread. 

63.10 Using withContext
As we have seen, coroutines are launched within a specified scope and using a specific dispatcher. By default, 
any child coroutines will inherit the same dispatcher as that used by the parent. Consider the following code 
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designed to call multiple functions from within a suspend function:
fun startTask(view: View) {

 

    coroutineScope.launch(Dispatchers.Main) {

        performTasks()

    }

}

 

suspend fun performTasks() {

    performTask1()

    performTask2()

    performTask3()

}

 

suspend fun performTask1() {

    Log.i(TAG, "Task 1 ${Thread.currentThread().name}")

}

 

suspend fun performTask2() {

    Log.i(TAG, "Task 2 ${Thread.currentThread().name}")

}

 

suspend fun performTask3 () {

    Log.i(TAG, "Task 3 ${Thread.currentThread().name}")

}

Since the performTasks() function was launched using the Main dispatcher, all three functions will default to the 
main thread. To prove this, the functions have been written to output the name of the thread in which they are 
running. On execution, the Logcat panel will contain the following output:
Task 1 main

Task 2 main

Task 3 main

However, imagine that the performTask2() function performs network-intensive operations more suited to 
the IO dispatcher. This can easily be achieved using the withContext launcher, which allows the context of a 
coroutine to be changed while still staying in the same coroutine scope. The following change switches the 
performTask2() coroutine to an IO thread:
suspend fun performTasks() {

    performTask1()

    withContext(Dispatchers.IO) { performTask2() }

    performTask3()

}

When executed, the output will read as follows, indicating that the Task 2 coroutine is no longer on the main 
thread:
Task 1 main

Task 2 DefaultDispatcher-worker-1
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Task 3 main

The withContext builder also provides an interesting alternative to using the async builder and the Deferred 
object await() call when returning a result. Using withContext, the code from the previous section can be 
rewritten as follows:
fun startTask(view: View) {

 

    coroutineScope.launch(Dispatchers.Main) {

          statusText.text = performSlowTask()

    }

}

 

suspend fun performSlowTask(): String =

    withContext(Dispatchers.Main) {

        Log.i(TAG, "performSlowTask before")

        delay(5_000)

        Log.i(TAG, "performSlowTask after")

 

        return@withContext "Finished"

    }

}

63.11 Coroutine Channel Communication
Channels provide a simple way to implement communication between coroutines, including streams of data. 
In the simplest form, this involves the creation of a Channel instance and calling the send() method to send the 
data. Once sent, transmitted data can be received in another coroutine via a call to the receive() method of the 
same Channel instance. 

The following code, for example, passes six integers from one coroutine to another:
.

.

import kotlinx.coroutines.channels.*

.

.

val channel = Channel<Int>()

 

suspend fun channelDemo() {

    coroutineScope.launch(Dispatchers.Main) { performTask1() }

    coroutineScope.launch(Dispatchers.Main) { performTask2() }

}

 

suspend fun performTask1() {

    (1..6).forEach {

        channel.send(it)

    }

}
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suspend fun performTask2() {

    repeat(6) {

        Log.d(TAG, "Received: ${channel.receive()}")

    }

}

When executed, the following logcat output will be generated:
Received: 1

Received: 2

Received: 3

Received: 4

Received: 5

Received: 6

63.12 Summary
Kotlin coroutines provide a simpler and more efficient approach to performing asynchronous tasks than 
traditional multi-threading. Coroutines allow asynchronous tasks to be implemented in a structured way 
without implementing the callbacks associated with typical thread-based tasks. This chapter has introduced the 
basic concepts of coroutines, including jobs, scope, builders, suspend functions, structured concurrency, and 
channel-based communication. 
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Chapter 80

80. An Android Picture-in-Picture 
Tutorial
Following the previous chapters, this chapter will take the existing VideoPlayer project and enhance it to add 
Picture-in-Picture support, including detecting PiP mode changes and adding a PiP action designed to display 
information about the currently running video.

80.1 Adding Picture-in-Picture Support to the Manifest
The first step in adding PiP support to an Android app project is to enable it within the project Manifest file. 
Open the manifests -> AndroidManifest.xml file and modify the activity element to enable PiP support:
.

.

<activity 

   android:name=".MainActivity"

   android:supportsPictureInPicture="true"
   android:configChanges="screenSize|smallestScreenSize|screenLayout|orientation"
   android:exported="true">
     <intent-filter>

         <action android:name="android.intent.action.MAIN" />

         <category android:name="android.intent.category.LAUNCHER" />

     </intent-filter>

</activity>

.

.

80.2 Adding a Picture-in-Picture Button
As currently designed, the layout for the VideoPlayer activity consists solely of a VideoView instance. As 
currently designed, the layout for the VideoPlayer activity consists solely of a VideoView instance. A button will 
now be added to the layout to switch to PiP mode. Load the activity_main.xml file into the layout editor and drag 
a Button object from the palette onto the layout so that it is positioned as shown in Figure 80-1:

Figure 80-1
Change the text on the button to read “Enter PiP Mode” and extract the string to a resource named enter_pip_
mode. Before moving on to the next step, change the ID of the button to pipButton and configure the onClick 
attribute to call a method named enterPipMode.
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80.3 Entering Picture-in-Picture Mode
The enterPipMode onClick callback method must now be added to the MainActivity.kt class file. Locate this file, 
open it in the code editor, and add this method as follows:
.

.

import android.app.PictureInPictureParams
import android.util.Rational
import android.view.View
import android.content.res.Configuration
.

.

fun enterPipMode(view: View) {
 
    val rational = Rational(binding.videoView1.width,
            binding.videoView1.height)
 
    val params = PictureInPictureParams.Builder()
            .setAspectRatio(rational)
            .build()
 
    binding.pipButton.visibility = View.INVISIBLE
    binding.videoView1.setMediaController(null)
    enterPictureInPictureMode(params)
}

The method begins by obtaining a reference to the Button view, then creates a Rational object containing 
the width and height of the VideoView. A set of Picture-in-Picture parameters is then created using the 
PictureInPictureParams Builder, passing through the Rational object as the aspect ratio for the video playback. 
Since the button does not need to be visible while the video is in PiP mode, it is invisible. The video playback 
controls are also hidden, so the video view will be unobstructed while in PiP mode. 

Compile and run the app on a device or emulator running Android version 8 or newer and wait for video 
playback to begin before clicking on the PiP mode button. The video playback should minimize and appear in 
the PiP window as shown in Figure 80-2:

Figure 80-2
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Click in the PiP window, then click within the full-screen mode markers that appear in the center of the window. 
Although the activity returns to full-screen mode, the button and media playback controls remain hidden.

Clearly, some code must be added to the project to detect when PiP mode changes occur within the activity.

80.4 Detecting Picture-in-Picture Mode Changes
As discussed in the previous chapter, PiP mode changes are detected by overriding the 
onPictureInPictureModeChanged() method within the affected activity. n this case, the method must be written 
to detect whether the activity is entering or exiting PiP mode and to take appropriate action to re-activate the 
PiP button and the playback controls. Remaining within the MainActivity.kt file, add this method now:
override fun onPictureInPictureModeChanged(

       isInPictureInPictureMode: Boolean, newConfig: Configuration) {

    super.onPictureInPictureModeChanged(isInPictureInPictureMode, newConfig)

    if (isInPictureInPictureMode) {

 

    } else {

        binding.pipButton.visibility = View.VISIBLE

        binding.videoView1.setMediaController(mediaController)

    }

}

When the method is called, it is passed a Boolean value indicating whether the activity is now in PiP mode. 
The code in the above method checks this value to decide whether to show the PiP button and to re-activate the 
playback controls.

80.5 Adding a Broadcast Receiver
The final step in the project is to add an action to the PiP window. The purpose of this action is to display 
a Toast message containing the name of the currently playing video. This will require some communication 
between the PiP window and the activity. One of the simplest ways to achieve this is to implement a broadcast 
receiver within the activity and use a pending intent to broadcast a message from the PiP window to the 
activity. Each time the activity enters PiP mode, these steps must be performed, so code must be added to the 
onPictureInPictureModeChanged() method. Locate this method now and begin by adding some code to create 
an intent filter and initialize the broadcast receiver:
.

.

import android.content.BroadcastReceiver
import android.content.Context
import android.content.Intent
import android.content.IntentFilter
import android.widget.Toast
 

class MainActivity : AppCompatActivity() {

.

.

    private val receiver: BroadcastReceiver? = null
.
.
override fun onPictureInPictureModeChanged(
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      isInPictureInPictureMode: Boolean, newConfig: Configuration) {

    super.onPictureInPictureModeChanged(isInPictureInPictureMode, newConfig)

    if (isInPictureInPictureMode) {

        val filter = IntentFilter()
        filter.addAction(
                "com.ebookfrenzy.videoplayer.VIDEO_INFO")
 
        val receiver = object : BroadcastReceiver() {
            override fun onReceive(context: Context,
                                   intent: Intent) {
                Toast.makeText(context,
                        "Favorite Home Movie Clips",
                        Toast.LENGTH_LONG).show()
            }
        }
 
        registerReceiver(receiver, filter, Context.RECEIVER_EXPORTED)
    } else {

        binding.pipButton.visibility = View.VISIBLE

        binding.videoView1.setMediaController(mediaController)

 

        receiver?.let {
            unregisterReceiver(it)
        }
    }

}

80.6 Adding the PiP Action
With the broadcast receiver implemented, the next step is to create a RemoteAction object configured with an 
image to represent the action within the PiP window. 

For this example, an image icon file named ic_info_24dp.xml will be used. This file can be found in the project_
icons folder of the source code download archive available from the following URL:

https://www.payloadbooks.com/product/koalakotlin/

Locate this icon file and copy and paste it into the app -> res -> drawables folder within the Project tool window:

Figure 80-3

https://www.payloadbooks.com/product/koalakotlin/
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The next step is to create an Intent that will be sent to the broadcast receiver. This intent then needs to be 
wrapped up within a PendingIntent object, allowing the intent to be triggered later when the user taps the action 
button in the PiP window.

Edit the MainActivity.kt file to add a method to create the Intent and PendingIntent objects as follows:
.

.

import android.app.PendingIntent
import android.app.PendingIntent.FLAG_IMMUTABLE
.

.

class MainActivity : AppCompatActivity() {

 

    private val REQUEST_CODE = 101
.
.
    private fun createPipAction() {
 
        val actionIntent = Intent("com.ebookfrenzy.videoplayer.VIDEO_INFO")
 
        val pendingIntent = PendingIntent.getBroadcast(this@MainActivity,
                REQUEST_CODE, actionIntent, FLAG_IMMUTABLE)
    }
}

Now that both the Intent object and the PendingIntent instance in which it is contained have been created, a 
RemoteAction object needs to be created containing the icon to appear in the PiP window and the PendingIn-
tent object. Remaining within the createPipAction() method, add this code as follows:
.

.

import android.app.RemoteAction
import android.graphics.drawable.Icon
.

.

private fun createPipAction() {

 

    val actions = ArrayList<RemoteAction>()
 

    val actionIntent = Intent("com.ebookfrenzy.videoplayer.VIDEO_INFO")

 

    val pendingIntent = PendingIntent.getBroadcast(this@MainActivity,

            REQUEST_CODE, actionIntent, FLAG_IMMUTABLE)

 

    val icon = Icon.createWithResource(this, R.drawable.ic_info_24dp)
 
    val remoteAction = RemoteAction(icon, "Info", "Video Info", pendingIntent)
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    actions.add(remoteAction)
}

Now a PictureInPictureParams object containing the action needs to be created and the parameters applied so 
that the action appears within the PiP window:
private fun createPipAction() {

 

    val actions = ArrayList<RemoteAction>()

 

    val actionIntent = Intent("com.ebookfrenzy.videoplayer.VIDEO_INFO")

 

    val pendingIntent = PendingIntent.getBroadcast(this@MainActivity,

            REQUEST_CODE, actionIntent, FLAG_IMMUTABLE)

 

    val icon =

    Icon.createWithResource(this,

        R.drawable.ic_info_24dp)

 

    val remoteAction = RemoteAction(icon, "Info",

    "Video Info", pendingIntent)

 

    actions.add(remoteAction)

 

    val params = PictureInPictureParams.Builder()
                    .setActions(actions)
                    .build()
 
    setPictureInPictureParams(params)
}

The final task before testing the action is to make a call to the createPipAction() method when the activity enters 
PiP mode:
override fun onPictureInPictureModeChanged(

        isInPictureInPictureMode: Boolean, newConfig: Configuration) {

    super.onPictureInPictureModeChanged(isInPictureInPictureMode, newConfig)

.

.

        registerReceiver(receiver, filter, Context.RECEIVER_EXPORTED)

        createPipAction()
    } else {

        pipButton.visibility = View.VISIBLE

        videoView1.setMediaController(mediaController)

.

.
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80.7 Testing the Picture-in-Picture Action
Rerun the app and place the activity into PiP mode. Tap on the PiP window so that the new action button 
appears, as shown in Figure 80-4:

Figure 80-4
Click on the action button and wait for the Toast message to appear, displaying the name of the video:

Figure 80-5

80.8 Summary
This chapter has demonstrated the addition of Picture-in-Picture support to an Android Studio app project, 
including enabling and entering PiP mode and implementing a PiP action. This included using a broadcast 
receiver and pending intents to implement communication between the PiP window and the activity.
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Chapter 93

93. An Overview of Android In-App 
Billing
n the early days of mobile applications for operating systems such as Android and iOS, the most common 
method for earning revenue was to charge an upfront fee to download and install the application. Another 
revenue opportunity was soon introduced by embedding advertising within applications. The most common 
and lucrative option is to charge the user for purchasing items from within the application after installing it. This 
typically takes the form of access to a higher level in a game, acquiring virtual goods or currency, or subscribing 
to premium content in the digital edition of a magazine or newspaper. 

Google supports integrating in-app purchasing through the Google Play In-App Billing API and the Play 
Console. This chapter will provide an overview of in-app billing and outline how to integrate in-app billing into 
your Android projects. Once these topics have been explored, the next chapter will walk you through creating 
an example app that includes in-app purchasing features.

93.1 Preparing a Project for In-App Purchasing
Building in-app purchasing into an app will require a Google Play Developer Console account, details of which 
were covered previously in the “Creating, Testing and Uploading an Android App Bundle” chapter. You must also 
register a Google merchant account. These settings can be found by navigating to Setup -> Payments profile 
in the Play Console. Note that merchant registration is not available in all countries. For details, refer to the 
following page:

https://support.google.com/googleplay/android-developer/answer/9306917

The app must then be uploaded to the console and enabled for in-app purchasing. However, the console will 
not activate in-app purchasing support for an app unless the Google Play Billing Library has been added to the 
module-level build.gradle.kts file: 
dependencies {

.

.

    implementation(libs.billingclient.ktx)
.

.

}

Once the build file has been modified and the app bundle uploaded to the console, the next step is to add in-app 
products or subscriptions for the user to purchase.

93.2 Creating In-App Products and Subscriptions
Products and subscriptions are created and managed using the options listed beneath the Monetize section of 
the Play Console navigation panel, as highlighted in Figure 93-1 below:

https://support.google.com/googleplay/android-developer/answer/9306917
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Figure 93-1
Each product or subscription needs an ID, title, description, and pricing information. Purchases fall into the 
categories of consumable (the item must be purchased each time it is required by the user, such as virtual 
currency in a game), non-consumable (only needs to be purchased once by the user, such as content access), and 
subscription-based. Consumable and non-consumable products are collectively referred to as managed products.

Subscriptions are useful for selling an item that needs to be renewed regularly, such as access to news content 
or the premium features of an app. When creating a subscription, a base plan specifies the price, renewal period 
(monthly, annually, etc.), and whether the subscription auto-renews. Users can also be given discount offers and 
the option of pre-purchasing a subscription.  

93.3 Billing Client Initialization
Communication between your app and the Google Play Billing Library is handled by a BillingClient instance. 
In addition, BillingClient includes a set of methods that can be called to perform both synchronous and 
asynchronous billing-related activities. When the billing client is initialized, it will need to be provided with a 
reference to a PurchasesUpdatedListener callback handler. The client will call this handler to notify your app 
of the results of any purchasing activity. To avoid duplicate notifications, it is recommended to have only one 
BillingClient instance per app.

A BillingClient instance can be created using the newBuilder() method, passing through the current activity or 
fragment context. The purchase update handler is then assigned to the client via the setListener() method:
private val purchasesUpdatedListener =

    PurchasesUpdatedListener { billingResult, purchases ->

        if (billingResult.responseCode ==

            BillingClient.BillingResponseCode.OK

            && purchases != null

        ) {

            for (purchase in purchases) {

                // Process the purchases

            }

        } else if (billingResult.responseCode ==

            BillingClient.BillingResponseCode.USER_CANCELED

        ) {

            // Purchase canceled by the user

        } else {
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            // Handle errors here

        }

    }

 

billingClient = BillingClient.newBuilder(this)

    .setListener(purchasesUpdatedListener)

    .enablePendingPurchases(

        PendingPurchasesParams.newBuilder()

            .enableOneTimeProducts().build()

    )

    .build()

93.4 Connecting to the Google Play Billing Library
After successfully creating the Billing Client, the next step is initializing a connection to the Google Play 
Billing Library. A call must be made to the startConnection() method of the billing client instance to establish 
this connection. Since the connection is performed asynchronously, a BillingClientStateListener must be 
implemented to receive a callback indicating whether the connection was successful. Code should also be added 
to override the onBillingServiceDisconnected() method. This is called if the connection to the Billing Library is 
lost and can be used to report the problem to the user and retry the connection.

Once the setup and connection tasks are complete, the BillingClient instance will make a call to the 
onBillingSetupFinished() method, which can be used to check that the client is ready: 
billingClient.startConnection(object : BillingClientStateListener {

    override fun onBillingSetupFinished(

        billingResult: BillingResult

    ) {

        if (billingResult.responseCode ==

            BillingClient.BillingResponseCode.OK

        ) {

            // Connection successful

        } else {

            // Connection failed 

        }

    }

 

    override fun onBillingServiceDisconnected() {

        // Connection to billing service lost

    }

})

93.5 Querying Available Products
Once the billing environment is initialized and ready to go, the next step is to request the details of the products 
or subscriptions available for purchase. This is achieved by making a call to the queryProductDetailsAsync() 
method of the BillingClient and passing through an appropriately configured QueryProductDetailsParams 
instance containing the product ID and type (ProductType.SUBS for a subscription or ProductType.INAPP for 
a managed product):
val queryProductDetailsParams = QueryProductDetailsParams.newBuilder()
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    .setProductList(

        ImmutableList.of(

            QueryProductDetailsParams.Product.newBuilder()

                .setProductId(productId)

                .setProductType(

                    BillingClient.ProductType.INAPP

                )

                .build()

        )

    )

    .build()

 

billingClient.queryProductDetailsAsync(

    queryProductDetailsParams

) { billingResult, productDetailsList ->

    if (!productDetailsList.isEmpty()) {

        // Process list of matching products

    } else {

        // No product matches found

    }

}

The queryProductDetailsAsync() method is passed a ProductDetailsResponseListener handler (in this case, in 
the form of a lambda code block) which, in turn, is called and passed a list of ProductDetail objects containing 
information about the matching products. For example, we can call methods on these objects to get information 
such as the product name, title, description, price, and offer details.

93.6 Starting the Purchase Process
Once a product or subscription has been queried and selected for purchase by the user, the purchase process is 
ready to be launched. We do this by calling the launchBillingFlow() method of the BillingClient, passing through 
as arguments the current activity and a BillingFlowParams instance configured with the ProductDetail object 
for the purchased item. 
val billingFlowParams = BillingFlowParams.newBuilder()

    .setProductDetailsParamsList(

        ImmutableList.of(

            BillingFlowParams.ProductDetailsParams.newBuilder()

                .setProductDetails(productDetails)

                .build()

        )

    )

    .build()

 

billingClient.launchBillingFlow(this, billingFlowParams)

The success or otherwise of the purchase operation will be reported via a call to the PurchasesUpdatedListener 
callback handler outlined earlier in the chapter. 
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93.7 Completing the Purchase
When purchases are successful, the PurchasesUpdatedListener handler will be passed a list containing a Purchase 
object for each item. You can verify that the item has been purchased by calling the getPurchaseState() method 
of the Purchase instance as follows:
if (purchase.getPurchaseState() == Purchase.PurchaseState.PURCHASED) {

    // Purchase completed. 

} else if (purchase.getPurchaseState() == Purchase.PurchaseState.PENDING) {

    // Payment is still pending

}

Note that your app will only support pending purchases if a call is made to the enablePendingPurchases() method 
during initialization. A pending purchase will remain so until the user completes the payment process.

When the purchase of a non-consumable item is complete, it must be acknowledged to prevent a refund 
from being issued to the user. This requires the purchase token for the item, which is obtained via a call to the 
getPurchaseToken() method of the Purchase object. This token is used to create an AcknowledgePurchaseParams 
instance and an AcknowledgePurchaseResponseListener handler. Managed product purchases and subscriptions 
are acknowledged by calling the BillingClient’s acknowledgePurchase() method as follows:
billingClient.acknowledgePurchase(acknowledgePurchaseParams, 

                             acknowledgePurchaseResponseListener);

val acknowledgePurchaseParams = AcknowledgePurchaseParams.newBuilder()

    .setPurchaseToken(purchase.purchaseToken)

    .build()

 

val acknowledgePurchaseResponseListener = AcknowledgePurchaseResponseListener {

    // Check acknowledgement result

}

 

billingClient.acknowledgePurchase(

    acknowledgePurchaseParams,

    acknowledgePurchaseResponseListener

)

For consumable purchases, you will need to notify Google Play when the item has been consumed so that it 
is available to be repurchased by the user. This requires a configured ConsumeParams instance containing a 
purchase token and a call to the billing client’s consumePurchase() method: 
val consumeParams = ConsumeParams.newBuilder()

    .setPurchaseToken(purchase.purchaseToken)

    .build()

 

coroutineScope.launch {

    val result = billingClient.consumePurchase(consumeParams)

 

    if (result.billingResult.responseCode == 

                     BillingClient.BillingResponseCode.OK) {

        // Purchase successfully consumed

    }
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}

93.8 Querying Previous Purchases
When working with in-app billing, checking whether a user has already purchased a product or subscription is a 
common requirement. A list of all the user’s previous purchases of a specific type can be generated by calling the 
queryPurchasesAsync() method of the BillingClient instance and implementing a PurchaseResponseListener. 
The following code, for example, obtains a list of all previously purchased items that have not yet been consumed:
val queryPurchasesParams = QueryPurchasesParams.newBuilder()

    .setProductType(BillingClient.ProductType.INAPP)

    .build()

 

billingClient.queryPurchasesAsync(

    queryPurchasesParams,

    purchasesListener

)

.

.

private val purchasesListener =

    PurchasesResponseListener { billingResult, purchases ->

 

        if (!purchases.isEmpty()) {

            // Access existing active purchases

        } else {

            // No 

        }

    }

To obtain a list of active subscriptions, change the ProductType value from INAPP to SUBS.

Alternatively, to obtain a list of the most recent purchases for each product, make a call to the BillingClient 
queryPurchaseHistoryAsync() method:
val queryPurchaseHistoryParams = QueryPurchaseHistoryParams.newBuilder()

    .setProductType(BillingClient.ProductType.INAPP)

    .build()

 

billingClient.queryPurchaseHistoryAsync(queryPurchaseHistoryParams) { 
billingResult, historyList ->

    // Process purchase history list

}

93.9 Summary
In-app purchases provide a way to generate revenue from within Android apps by selling virtual products and 
subscriptions to users. This chapter explored managed products and subscriptions and explained the difference 
between consumable and non-consumable products. In-app purchasing support is added to an app using the 
Google Play In-app Billing Library. It involves creating and initializing a billing client on which methods are 
called to perform tasks such as making purchases, listing available products, and consuming existing purchases. 
The next chapter contains a tutorial demonstrating the addition of in-app purchases to an Android Studio 
project.
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